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Sažetak 

Kako se današnji svijet bazira na medijima, odnosno, oni grade mišljenja ljudi, tako također 

postoje mediji koji se ističu sa svojom interakcijom i po tome kako privlače pažnju na sebe. Jedan 

od njih je 3D animacija. Rad počinje objašnjavajući što je to uopće 3D animacije te kakva je razlika 

između 2D i 3D slike. To pomaže čitatelju da shvati koja je temeljna razlika te da vidi koliko se 

zapravo 3D animacija razlikuje po zahtjevnosti izrade i izgledu od 2D animacije. Slijedi 

objašnjavanje svakog koraka izrade 3D animacije. Prvi je skiciranje u kojem se objašnjava svaki 

od 10 koncepta smišljenih u svrhu ovog rada. U nastavku će se objasniti sučelje svakog programa 

koji se koristio za izradu 3D animacije. Ti programi su Autodesk Maya, Adobe Premiere Pro i 

After Effects od kojih se većinom, u ovom radu, Autodesk Maya koristi za modeliranje i 

animiranje, After Effects za animiranje te Adobe Premiere Pro za spajanje renderiranih slika. Veća 

pažnja će biti usmjerena na samo postavljanje scene, izradu 3D modela te samo animiranje. 

 

Ključne riječi: animacija, 2D, 3D, mediji, programi, slika 

 

 

Summary 

As the world nowadays is based on the media, moreover, they form the opinions of the people, 

there is also the media that stands out with its interaction and how it attracts attention to itself. One 

of them is 3D animation. This paper begins by explaining what is 3D animation and what is the 

difference between 2D and 3D image. That helps the reader to understand fundamental difference 

and see how actually 3D animation  differs. It differs by its making complexity and layout 

compared to 2D animation. Coming up in the final work is the explanation of each step of making 

3D animation. The first one is sketching in which each step of the 10 concepts made for this work 

is explained. The following is an explanation of the interface of each program that was used for 

making this 3D animation. These programs are Autodesk Maya, Adobe Premiere Pro and After 

Effects. In this work, I used Autodesk Maya for modeling and animation, After Effects for 

animation and Adobe Premiere Pro for merging rendered images. The attention will be more on 

setting the scene, creating 3D models and animation. 

 

Keywords: animations, 2D, 3D, media, programs, images  
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1. Uvod  

3D animacija je proces generiranja pokretnih 3D slika u digitalnom okruženju, odnosno, može 

se reći da je to jedna vrsta umjetnosti korištenja računalne grafike za stvaranje pokreta u 3D 

okruženju. Da bi se došlo do same animacije, postoji niz koraka koji se prije moraju napraviti. Prvi 

korak je skiciranje animacije, kojim se želi prikazati kako će to u suštini izgledati. Skica može 

pomoći u daljnjoj realizaciji animacije. Drugi korak je  kreiranje 3D modela, kojemu se dodaje 

željena tekstura. Za stvaranje teksture se mogu koristiti razni programi poput: Adobe Photoshop, 

Substance painter, Neo Textures, Map Zone i mnogi drugi. Nakon toga se tomu 3D modelu dodaje 

virtualni kostur koji će se kasnije koristiti za animiranje. Prilikom dodavanja teksture, dodaju se 

svjetla sceni, jer bez svjetla.  model se neće vidjeti. Tek onda slijedi animacija te na kraju 

renderiranje koje je krajnji rezultat računalne grafike.  

 

Prilikom renderiranja stvaraju se slike u određenoj rezoluciji, koje se tada u posebnom 

programu spajaju u jednu video animaciju. Da bi te spojene slike vidjele kao video, moraju se 

vrtjeti najmanje 24 puta u sekundi, odnosno, 24 slika u sekundi.  

Primjena 3D animacije je široka. Koristi se u video igrama za stvaranje pokreta 3D okruženja, 

likova koji se mogu prenositi u virtualna okruženja te se njima može manipulirati u realnom 

vremenu pomoću igraćih kontrola. Koristi se u filmskoj produkciji za stvaranje specijalnih efekata, 

gdje se kombinacijom snimaka i generiranih slika stvaraju okruženja koja izgledaju realno, a bile 

bi preduge, preskupe i preopasne za proizvesti pomoću stvarnih glumaca i scena. Također se mogu 

stvoriti grube 3D scene s digitalnim glumcima. To su obične grube scene koje se koriste za 

planiranje i konceptualizaciju scena prije snimanja. Korištenjem programa za 3D animaciju, autori 

filma mogu svoje apstraktne koncepte lako pretvoriti u animirani storyboard. 

 

Postoji niz programa za 3D animaciju a neki od tih su: 3ds Max, Autodesk Maya, Blender, 

Motionbuilder, Cinema 4D, Clara.io, Houdini itd. Osim što se ti programi koriste za animaciju, 

također se koriste za 3D modeliranje, teksturiranje i renderiranje. 

Za produkciju mnogih poznatih filmova su korišteni navedeni programi. Tako je Maya 

korištena u produkciji filmova: Avatar, Transformers, Frozen, Ledeno doba, Potraga za Nemom. 

3ds Max je korišten u produkciji filmova: Alisa u zemlji čudesa, Hellboy, Spider-Man 3, Zvjezdani 

ratovi. 
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Kroz završni rad bit će  objašnjena razliku između 2D i 3D animacije, dok će više fokus biti na 

3D animaciju. Ukratko će se objasniti sučelje programa Autodesk Maya, After Effects, Adobe 

Premiere Pro te više objasniti postupak izrade 3D animacije logotipa Sveučilišta Sjever. Odnosno, 

proći će se kroz korake smišljanja animacije, izrade 3D modela, teksturiranje tog modela, 

animaciju, renderiranje te spajanje renderiranih slika. 
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2. Razlika između 3D i 2D animacije 

Razlika između 2D i 3D animacije je ta što se kod 2D animacije sve događa u 2 dimenzije, 

slike su ravne te daju pogled iz samo jednog kuta, slika nema dubinu, već samo širinu i visinu. 

Kod 3D animacije imamo 3 dimenzije: širina, visina i dubina. Ta dodatna dimenzija, dubina, 

omogućuje da se vide slike kao i u realnom svijetu.  

 

Slika 2.1 Razlika između 2D i 3D lika [1] 

 

Kada se gleda iz pogleda animacije, 2D animacija se većinom sastoji od niza crteža, likova na 

ravnoj podlozi koji se pomoću računala pretvaraju u 2D bitmap ili vektorsku grafiku. Likovi se 

kod 2D animacije mogu kretati u 4 smjera: gore, dolje, lijevo i desno.  Kod 3D animacije izrađuju 

se 3D modeli pomoću računalnih programa kojima se dodaju sjene, svjetla, teksture, refleksije te 

tako i pripadajuća okolina. 

 

2D animacije je jeftinija u odnosu na 3D animaciju zato što kod 2D samo trebamo osobe koje 

znaju odlično crtati dok kod 3D imamo više procesa,  za svaki proces treba određeni profesionalac 

te se dodatno plaćaju programi za izradu. 

 

 

Slika 2.2 Razlika između 2D i 3D filma [2] 
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3. Koraci izrade 3D animacije 

3.1. Skiciranje 

Prilikom skiciranja želja je da se objektivno prikaže kako će animacije na kraju izgledati. 

Skicirati se može na papiru pomoću olovke ili u digitalnom obliku koristeći jedan od programa za 

grafiku poput: Adobe Photoshop, Adobe Illustrator, CorelDraw, Gimp i dr. 

Za ovaj rad izmišljeno je 10 koncepta te je svaki od koncepta skiciran u Photoshopu. Od tih 10  

odabrano je 3 najbolja te je na temelju njih izrađena 3D animacija čiji  koraci će kasnije kroz rad 

biti detaljnije objašnjeni. 

 

 

Slika 3.1 Primjer skice animacije [3] 
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3.1.1. Koncept 1 – iscrtavanje logotipa 

 

Slika 3.2 Koncept 1 

 

Na sceni se pojavljuje papir iz određenog kuta. Na papiru se počinju iscrtavati vanjske linije UNIN 

logotipa. Papir se približava kameri dok se istovremeno logo sve više iscrtava. Sve više se 

primjećuje oblik UNIN logotipa. Papir je sada u paralelnom položaju u odnosu na kameru te se 

počinje ispunjavati logo. Na kraju se dobije ispunjeni logo  na papiru. 
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3.1.2. Koncept 2 – preobrazba 

 

 

Scena počinje tako što se prikazuje knjigu koja se vrti ujednačenom brzinom. Brzina vrtnje knjige 

raste sve dok ne postaje mutno za oko. Tada se knjiga pretvori u diplomu koja kruži ujednačenom 

brzinom. Brzina vrtnje diplome raste sve dok ne postaje mutno za oko. Diploma se pretvara u 

UNIN logotip koji kruži ujednačenom brzinom. Na kraju se logo pozicionira paralelno s kamerom 

te se kamera polako udaljava i na kraju prikazuje logo u total planu. 

 

 

 

 

 

 

Slika 3.3 Koncept 2 
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3.1.3. Koncept 3 – formiranje logotipa iz knjige 

 

Slika 3.4 Koncept 3 

 

Scena počinje prikazujući knjigu koja se otvara. Knjiga se otvori te iz nje počinju izlazi male 

kockice. Sve više kockica izlazi iz knjige. Male kockice počinju tada formirati UNIN logotip. Sve 

više se formira logo dok knjiga nestaje. Na kraju se dobije formirani 3D UNIN logo. Kamera se 

polako udaljava i na kraju prikazuje logo u total planu. 
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3.1.4. Koncept 4 – stvaranje vanjskih linija i ispuna 

 

Slika 3.5 Koncept 4 

 

Scena počinje tako da se pojavljuju male kockice koje kruže. Male kockice počinju formirati 

vanjske linije logotipa. Nakon nekog vremena formiraju se vanjske linije logotipa te se tada on 

počinje ispunjavati. Ispunjavanje se može raditi od dolje prema gore ili iznutra prema van. Logo 

se sve više ispunjava. Na kraju se dobije ispunjeni logotip. 
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3.1.5. Koncept 5 – rotacija dijelova 

 

Slika 3.6 Koncept 5 

 

Na praznoj sceni se pojavljuju rotirajući dijelovi logotipa. Kako se dijelovi rotiraju, malo po malo 

formiraju logo. Logo se sve više formira. Kamera može kružiti iznad logotipa. Dijelovi se i dalje 

rotiraju dok se kamera polako udaljava i na kraju prikazuje total plan formiranog logotipa.  
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3.1.6. Koncept 6 – prikazivanje logotipa 

 

Slika 3.7 Koncept 6 

 

Scena počinje tako što kamera radi prelazak preko UNIN logotipa. Prelazi s jedne na drugu stranu 

prikazujući logo po njegovoj širini. Nakon toga se kamera polako udaljava i na kraju prikazuje 

total plan formiranog logotipa.  
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3.1.7. Koncept 7 – prijelaz preko UNIN zgrada 

 

 

Slika 3.8 Koncept 7 

 

Scena počinje tako da kamera radi prelazak preko 3D modela UNIN zgrada. Kamera radi lagani 

zoom out te prikazuje 3 UNIN zgrade koje čine formaciju okrenutog slova „T“. Kamera se polako 

udaljava dok istovremeno zgrade pomalo nestaju te se pojavljuju dijelovi UNIN logotipa. Na kraju 

se dobije total plan logotipa.  

 

 

 

 

 

 

 

 

 



12 

 

3.1.8. Koncept 8 – efekt disperzije 

 

 

Slika 3.9 Koncept 8 

 

Scena počinje tako što se kamera kreće kroz sitne kockice koje, malo po malo, formiraju 3D UNIN 

logo. S vremenom se pojavljuje se sve  više kockica. Cijelo to vrijeme, kamera prikazuje krupni 

plan. Nakon nekog vremena kamera se polako udaljava i na kraju prikazuje total plan formiranog 

UNIN logotipa. 
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3.1.9.  Koncept 9 – vodeni efekt 

 

Slika 3.10 Koncept 9 

 

 

Scena počinje tako što kamera prikazuje krupni plan UNIN logotipa. Logo je na početku 

napravljen od stakla, proziran je. Nakon nekog vremena logo se počinje puniti tekućom crvenom 

bojom koja se odbija od unutarnjih površina logotipa. Nakon nekoga vremena kamera se polako 

udaljava i logotip se sve više i više puni tekućom crvenom bojom. Na kraju je prikazan total plan 

napunjenog 3D logotipa. 
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3.1.10. Koncept 10 – Morph efekt 

 

 

Slika 3.11 Koncept 10 

 

Ovaj koncept je sličan konceptu 2 – preobrazba, samo što će se kod ovog koncepta koristiti Morph 

efekt za transformaciju iz jednog modela u drugi. Scena počinje tako što se prikazuje knjigu koja 

se vrti ujednačenom brzinom. Nakon nekog vremena knjiga mijenja oblik te se pretvara u diplomu. 

Diploma se vrti ujednačenom brzinom dok nakon nekog vremena mijenja oblik i pretvara se u 

UNIN logotip koji kruži ujednačenom brzinom. Na kraju se logo  pozicionira paralelno s kamerom 

te se kamera polako udaljava i na kraju prikazuje logo u total planu. 
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3.2. Izrada 3D modela 

3D modeliranje je proces korištenja programa za stvaranje trodimenzionalnog objekta ili 

oblika. Kao što je navedeno ranije, kreirani model se zove 3D model jer ima 3 dimenzije: širinu, 

visinu i dubinu. Napravljeni model može biti prikazan pomoću 2D slike koristeći proces 

renderiranja te kao realni 3D model koristeći 3D printer. 

 

Postoje 3 vrste izrade 3D modela: 

1. Kostur (eng. Wireframe) modeliranje 

Kod ovog modeliranje kreiraju se 3D modeli koji se opisuju pomoću kostura. Kod ovih 

modela ne postoji površina, već se on sastoji od točaka, linija i krivulja koje opisuju rubove 

objekta. Kostur modeli se mogu kreirati tako da se postavi 2D objekt bilo gdje u 3D prostor. 

Kreiranje ovih modela može uzeti najviše vremena jer se svaki objekt koji čini kostur model 

mora crtati i pozicionirati zasebno. 

 

Slika 3.12 Primjer Wireframe modela [4] 

 

2. Površinsko (eng. Surface) modeliranje 

Ovaj način modeliranje je više sofisticiraniji nego kostur modeliranje jer ne definira samo 

rubove 3D modela već i njegove površine. Osoba koja radi ovu vrstu modeliranja definira 

površine lica koristeći poligonalnu mrežu. Zbog toga što su lica mreže plosnata, mreža 

može samo spojiti zakrivljene površine.  
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Slika 3.13 Primjer Surface modela [5] 

 

3. Čvrsto (eng. Solid) modeliranje 

Predstavlja najjednostavniji tip 3D modeliranja. Koristeći ovu vrstu modeliranja, mogu se 

izraditi modeli kreiranjem osnovnih 3D oblika: kutije, cilindri, sfere, klinovi i krafne. Tada, 

kombinirajući navedene oblike mogu se kreirati kompliciraniji model tako da ih se spaja, 

oduzima ili preklapa. 

 

Slika 3.14 Primjer Solid modela [6] 

 

Zbog razloga što svako od navedenih modeliranja koristi različite metode modeliranja, 

preporučuje se da se one ne kombiniraju međusobno, te isto tako, nije moguće pretvoriti model 

koji je napravljen pomoću jedne od navedenih metoda u model druge metode. Ranije navedeni 

programi poput: Autodesk Maya, Blender, Houdini itd., svi se mogu koristiti za izradu 3D modela. 
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Za izradu 3D modela ovog rada korišten je program AutoDesk Maya te tehnika čvrstog (eng. 

Solid) modeliranja. 

 

Sučelje programa Autodesk Maya: 

 

 

Slika 3.15 Korisničko sučelje programa Autodesk Maya 

 

1. Kutija alata (eng. Toolbox) – niz alata koji omogućuje prebacivanje između različitih 

alata za manipuliranje objektima. Premještanje, skaliranje i okretanje su najbitniji. 

2. Mjesta i police - ovdje su razni Mayini izbornici od dodavanja svjetla, kreiranja modela, 

pokretanja renderiranja itd. 

3. Kutije kanala - Ovaj prostor prvenstveno zauzima kutije kanala gdje se mogu mijenjati 

geometrijski parametri. Ovdje se mogu dodati drugi ulazni prozori, najčešće postavke alata 

za uređivanje atributa i alata. 

4. Ploča s panoramski prikazom – ovdje se prikazuje modeliranje, animiranje, teksturiranje. 

Odnosno, laički rečeno, ovdje se prikazuje „akcija“. 

5. Uređivač slojeva – pomoću ovoga može se upravljati složenim scenama, mogu se 

isključiti ili zaključati određeni slojevi što olakšava modeliranje, animiranje i teksturiranje. 
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Za 3D animacije logotipa odabrani su koncepti 2, 3 i 10. Iz tog razloga trebaju se izraditi 3D modeli 

UNIN logotipa, knjige i diplome. Prvo je izrađen model logotipa na taj način da je prvo uvezena  

fotografiju logotipa u Mayu pomoću View → Image plane → Import. 

Na temelju te fotografije izrađen je križ i vanjski kvadrati  koristeći alat Create Polygonal Cube. 

 

 

Slika 3.16 Prikaz alata Create Polygonal Cube 

 

 

 

Slika 3.17 Prikaz 3D UNIN logotipa bez slova 
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Tada su, koristeći alat Polygon Type, napisana slova koje se nalaze na originalnom logotipu.  

Font slova je UNIN font koji je napravljen posebno za Sveučilište Sjever. 

 

 

Slika 3.18 Prikaz 3D UNIN logotipa sa slovima 

 

Iduće su napravljeni modeli knjige i diplome. Knjiga je napravljena u 2 dijela jer je za animaciju 

potrebno da se otvara. 

 

Slika 3.19 Prikaz 3D modela knjige bez teksture 
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Slika 3.20 Prikaz 3D modela diplome bez teksture 
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Sučelje programa After Effects: 

 

 

Slika 3.21 Sučelje programa After Effects  

 

 

1. Vremenska crta -  prikazuje sadržaj trenutnog sastava na kojem se radi. Na lijevoj strani 

mogu se vidjeti svi slojevi trenutnog sastava i ovdje se može upravljati njihovim 

redoslijedom i svojstvima. Na desnoj strani se nalazi traka koja pokazuje kada određeni 

sloj završava ili počinje. 

2. Projektni prozor -  prikazuje popis svih datoteka koje su uvezene u projekt, kao i sve 

projekte koji su izrađeni trenutno.  

3. Efekti i predlošci efekata -  jedan od najvažnijih izbornika. Ovdje se mogu pronaći svi 

dostupni efekti kao i unaprijed definirani predlošci raznih efekata.  

4. Podesivi alatni paneli – na desnoj strani nalaze se brojni alatni paneli. Mogu biti 

konfigurirani ili se mogu namjestiti prema osobnom izboru. 

5. Prozor za pregled – ovdje se vidi kako trenutni sastav izgleda. Dok se nešto promijeni u 

sastavu, prozor za pregled će se automatski ažurirati. 
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Sučelje programa Adobe Premiere Pro: 

 

Slika 3.22 Sučelje programa Adobe Premiere Pro  

 

 

1. Prozor za pregled - ovdje se vidi kako trenutni sastav izgleda. Dok se nešto promijeni u 

sastavu, prozor za pregled će se automatski ažurirati. 

2. Vremenska crta - prikazuje sadržaj trenutnog sastava na kojem se radi. Na lijevoj strani 

mogu se vidjeti svi slojevi trenutnog sastava i ovdje se može upravljati njihovim 

redoslijedom i svojstvima. Na desnoj strani se nalazi traka koja pokazuje kada određeni 

sloj završava ili počinje. 

3. Aplicirani efekti – prikazuje efekte koji su aplicirani na trenutno označeni sadržaj. 

4. Projektni prozor – prikazuje popis svih datoteka koje su uvezene u projekt, kao i sve 

projekte koje su izrađene trenutno. 

5. Dostupni efekti – prikazuje popis svih efekata koje program nudi. 

6. Alati – alati koji omogućuju uređivanje sadržaja na vremenskoj crti. 
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3.3. Teksturiranje 

Prije nego što se krene raditi teksturiranje 3D modela, postoji par pojmova koji se moraju 

objasniti i znati. 

3.3.1. Mapiranje tekstura 

Da bi se stvorila površina koja nalikuje površini u stvarnom životu mora se napraviti postupak 

mapiranja tekstura. Taj je postupak sličan dodavanju ukrasnog papira na bijelu kutiju. Kod 3D 

modeliranja, mapiranje teksture je proces dodavanja grafike na objekt poligona. Ove grafike mogu 

biti sve, od fotografija do originalnih dizajna. Teksture mogu pomoći dodavanju realnosti i 

privlačnosti napravljenom modelu.  

 

 

Slika 3.23 Primjer mapiranja teksture [7] 

3.3.2. Shader 

Shader opisuje cijeli materijal na objektu, odnosno, govori kako će se svjetlost reflektirati, 

upijati, lomiti. Shader i teksture mogu biti zbunjujući, mogu se zamijeniti značenja. Međutim, 

tekstura je nešto što se povezuje sa Shaderom da bi 3D model dobio poseban izgled. 
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Slika 3.24 Primjeri Shadera [7] 

3.3.3. UV mapiranje 

3D objekt ima mnogo strana na koje računalo ne zna kako staviti teksturu. UV mapa je u osnovi 

rastegnuta u plosnatu 2D sliku. Svako lice na 3D objektu je vezano za lice na UV mapi. Kada 

postoji 2D fotografije UV mape, lakše je staviti teksturu na model. 

 

 

Slika 3.25 UV mapiranja teksture dinosaura [7] 



25 

 

3.3.4. Refleksija 

Kao što sama riječ govori, refleksija definira kako će se svjetlost odbijati od površine objekta. 

To je zapravo refleksija svjetla dodane teksture. Imati dobro zadane vrijednosti refleksije je važno 

za određivanje od čega je materijal objekta napravljen. Na primjer, sjajniji materijal će imati veću 

refleksiju, dok tekstura poput cementa neće. 

 

 

Slika 3.26 Refleksije modela [8] 

3.3.5. Normala 

Normala je nevidljiva linija koja je usmjerena ravno iz lica poligona. Normale pomažu 3D 

programu da odredi koja je strana površine prednja a koja stražnja. Ispravna orijentacije normala 

je vrlo bitna, posebno kod renderiranje jer program neće renderirati stražnju stranu lica objekta, 

već se biti crna. 

 

Slika 3.27 Normale [7] 
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3.3.6. Mapa izbočina 

Mape izbočina daju iluziju dubine  ili reljefa bez značajnog povećanja vremena renderiranja. 

Na primjer, povišena površina na novčiću može biti lažirana korištenjem mape izbočina. 

Računalo određuje gdje treba biti izbočina, čitajući crne, bijele i sive vrijednosti skale na slici. 

 

 

Slika  3.28 Mapa izbočina na kovanici [7] 

3.3.7. Mapa transparentnosti 

Mape transparentnosti su teksture sive ljestvice koje koriste crno-bijele vrijednosti za 

označavanje područja prozirnosti ili neprozirnosti na materijalu predmeta. Na primjer, kada se 

modelira ograda, umjesto da se modelira svaka lančana veza pojedinačno, koje oduzima značajnu 

količinu vremena, može se koristiti crno-bijela tekstura kako bi se odredila koja područja bi trebala 

ostati neprozirna i što bi trebalo biti prozirno. 

 

Slika 3.29 Mapa transparentnosti na lopti [7] 
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3.3.8. Normalna mapa 

Normalna mapa stvara iluziju detalja bez potrebe za visokim brojem poligona. Na primjer, 

model može biti detaljno opisan u nekom programu poput Zbrush i onda sve te informacije se 

mogu prenijeti na normalnu mapu i na model, dajući tako iluziju detalja bez povećanja poligona 

modela. Studiji za razvoj video igara često koriste normalne mape jer im trebaju modeli sa što 

manjim brojem poligona. 

 

 

Slika 3.30 Normalna mapa [7] 

3.3.9. Normalna mapa vs. mapa izbočina 

Normalne mape i mape izbočina su slične po tome što obje utječu na normale objekta i stvaraju 

iluziju detalja bez potrebe dodatne geometrije. Velika razlika između njih je u tome što mape 

izbočina samo kodiraju informacije o visini koristeći crne i bijele vrijednosti, dok normalne mape 

koriste RGB vrijednosti da označe orijentaciju normala na površini. Informacije u crvenom, 

zelenom i plavom kanalu odgovaraju orijentaciji X, Y i Z. Normalne mape obično sadrže više 

informacije o površini objekta. 
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3.3.10.  Teksturiranje 3D UNIN logotipa 

Zbog razloga što je UNIN logotipa jedne boje, teksturiranje nije zahtijevalo izradu UV mapa, niti 

bilo kakve vrste mape, već je dodijeljen materijal jedne boje.  Proces je bio vrlo jednostavan.  

Prvo su označeni svi modeli te im je tada dodijeljen materijal držeći desni klik miša → Assign 

New Material → Vray Materials → Vray Mtl. Razlog zašto je odabran Vray materijal je taj što će 

se kasnije renderirati slike pomoću Vray plugin-a. 

 

Što se tiče karakteristika materijala, stavljene su ove: 

 

 

Slika 3.31 Karakteristike materijala UNIN logotipa 
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Želja je bila da se dobije materijal koji će imati malo refleksije u sebi, jer izgleda bolje nego bez 

refleksije. Refleksija će biti vidljiva prilikom renderiranja. Za teksturiranje knjige i diplome 

koristio se materijal Lambert kojemu su dodane boje crvena i bijela.  

 

 

Slika 3.32 3D model diplome s teksturom 

 

Slika 3.33 3D model knjige s teksturom 

Izvoz 3D modela i tekstura za daljnju animaciju moguće je pod File → Export all →.obj export. 
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3.4. 3D Animacija 

3D animacija je proces gdje se uzima 3D model te ga se stavlja u određeni prostor i pokreće, 

animira. Iako se nazivaju 3D, one nisu iste poput 3D filmova koji su dan danas popularni te koji 

stvaraju iluziju dubine. Zovu se 3D zbog načina na koji se izrađuju, koristeći 3D modele kako bi 

se prikazale scene prije nego se renderiraju.  

3.4.1. Tehnike 3D animiranja 

1. Obrnuta kinematika 

Tehnika gdje se pomoću kostura modela simuliraju prirodni pokreti tijela. Pojednostavljuje 

proces animacije i stvara kompliciranije animacije s manje napora. Obično se koristi kod 

pozicioniranja ruku i nogu. 

Animatori koriste ovu tehniku da bi simulirali pokrete poput savijanja koljena ili ležanja. 

Postiže se postavljanjem zadnje kosti lanca kostiju, što čini druge kosti automatski 

pozicioniranima. Npr., kada bi animirali šaku nekog lika po nekoj putanji, onda bi podlaktica i 

nadlaktica slijedile šaku. Ova tehnika se obično koristi u programima poput Autodesk Maya i 3ds 

Maxa. 

2. Simulacija fluida 

Ova tehnika se obično koristi za efekte poput erupcije vulkana, olujnog mora ili velikih 

vodopada. Tehnika se koristi u raznim područjima poput video igara, filmovima i reklamama.  

Simulacija fluida se koristi za generiranje realističnih animacije tekućih tijela poput vode, 

dima, oblaka, vatre itd. Programi poput Maye, Blendera i Houdini omogućuju korištenje ove 

tehnike. 

3. Kostur animacija 

Kostur animacija je tehnika kod koje se 3D objekt animira kombinacijom 2 tehnike: 

površinskog prikaza objekta kod kojeg tada animator nacrta objekt ili mrežu objekta i onda doda 

animaciju koristeći kombinaciju spojenih kostiju u jedan zajednički kostur. Ova tehnika se koristi 

za animaciju likova i bilo kojih pridruženih objekta. Npr., da bi animirali lik u igri, prvo mu se 

treba napraviti kostur i onda se taj kostur spoji s tijelom te se animira u određenim pozicijama na 

određenoj vremenskoj točki. 
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3.4.2. Vrste animacije 

1. 3D film / video 

Ova vrsta 3D animacije je najrasprostranjenija i najviše se koristi od triju vrsta koje postoje. 

Sve što se događa kod ove vrste je vizualno te nema nikakve interakcije s gledateljima. Bez 

obzira na to što je za ovu vrstu potrebno mnogo vremena i rada da se napravi, ona je 

najjednostavnija za napraviti, uspoređujući s ostale dvije.  Većinom se koristi u filmskoj industriji, 

neki od filmova koji su ove vrste: Priča o igračkama, Čudovište iz ormara, Potraga za Nemom, 

Auti itd. 

 

Slika 3.34 Priče o igračkama [9] 

2. Interaktivni 3D 

Vrsta koja ima isključivo digitalno okruženje stvoreno pomoću softvera za 3D. Dok se 3D film 

/ video animacije oslanjaju na vizualni doživljaj, ova sadrži i interakciju s korisnikom. Vrlo je 

zabavno jer omogućuje korisniku da bude u prvom licu i da se kreće unutar virtualnog 3D svijeta 

te aktivno odlučuje koje će akcije poduzeti u realnom vremenu. Najviše se koristi u video igrama. 
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Slika 3.35 Interaktivni 3D [10] 

3. Virtualna realnost 

Za ovu vrstu potrebni su ulazno-izlani uređaji poput Google naočala, Oculus ili slično jer 

također postoji interakcije s gledateljima. Za ovu vrstu je potrebno najviše rada i vremena za 

izradu. Koristi se u raznim područjima: video igre, edukacijski programi itd. 

Virtualna realnost otvara nova vrata što se tiče edukacije i oglašavanja. Kod učenja upravljanja 

zrakoplovom, učenik može vježbati u virtualnom zrakoplovu bez da odlazi u pravi, realni 

zrakoplov. U medicini se može koristiti tako da kirurzi uče ili usavršavaju rad s novim alatom bez 

rizika gubitka pacijenta.  Gledajući na mogućnosti koju virtualna realnost može donijeti, ova vrsta 

je najisplativija. 

 

Slika 3.36 Virtualna stvarnost [11] 
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3.4.5. 3D animacije UNIN logotipa 

Za ovu animaciju nije rađen kostur već je korištena improvizacija. Trajanje animacije je do 20 

sekundi, gledajući na to da je 24 slike u sekundi, znači, potrebno nam je 480 sličica.  

1. Koncept 2 - preobrazba 

Svi modeli postavljeni su na jednakoj visini, širini i dubini tako da dok jedan nestane, drugi mu 

zamjeni mjesto.  Da bi se animirao model, potrebno ga je staviti u neku poziciju i u određeno 

vrijeme te se onda pritisne slovo „s“ na tipkovnici, tako se postavlja oznaka na vremensku crtu 

koja govori kad neka tranzicija kreće. 

Prvi animirani model je knjiga kojoj je napravljena rotacija od 360 stupnjeva u desnu stranu u 

periodu od 1. do 96. sličice, dok je u periodu od 96. do 120. sličice napravljena rotacija od 1080 

stupnjeva, također u desnom smjeru.  

 

 

Slika 3.37 Animiranje 3D modela knjige 

 

 Cilj je bio da se knjiga prvo vrti ujednačenom brzinom te onda postepeno ubrza. Da bi ubrzala 

postepeno, potrebno je odabrati model knjige, otići u uređivač grafikona (eng. Graph editor) te 

postaviti krivulju prema slici: 
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Slika 3.38 Krivulja animirane knjige 

 

Drugi animirani model je diploma kojoj je napravljena rotacija od 180 stupnjeva u desnu stranu u 

periodu 120. do 216. sličice te rotacija od 450 stupnjeva u desnu stranu u periodu od 216. do 242. 

sličice. 

 

 

Slika 3.39 Animiranje 3D modela diplome 
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Kako je knjiga ubrzala potrebno je napraviti da diploma prvo ima veliku brzinu, postepeno 

usporava te nakon nekog vremena ubrzava. Da bi to bilo tako, potrebno je odabrati model diplome, 

otići u. Graph editor → Windows → Animation Editors → Graph Editor)  te postaviti krivulje 

prema slici: 

 

 

Slika 3.40 Krivulja animirane diplome 

Treći animirani model je UNIN logotip kojemu je napravljena rotacija u desnu stranu od 720 

stupnjeva. Kod ove animacije nije dodavana ni jedna nova kamera, već je pogled bio iz kamere za 

perspektivu.  

 

 

Slika 3.41 Animiranje 3D modela UNIN logotipa 
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Kako je diploma ubrzala potrebno je napraviti da logotip prvo ima veliku brzinu, postepeno 

usporava te nakon nekog vremena bude paralelno s kamerom. Da bi to bilo tako, potrebno je 

odabrati model logotipa, otići u uređivač grafikona (eng. Graph editor) te postaviti krivulje prema 

slici: 

 

Slika 3.42 Krivulja animiranog logotipa 

 

Da bi se dodalo svjetlo potrebno je otići pod Create → Lights → Vray Dome Lights. 

Razlog zašto je odabrano svjetlo kupole (eng. Dome light) je taj što pruža jednako osvjetljenje na 

svim mjestima, a to je bio i cilj. 

2. Koncept 3 - formiranje logotipa iz knjige 

Kod ove animacije, korišten je tzv. MASH (eng. Mreža). Cilj je bio napraviti par tisuća malih 

kockica koje bi kroz neko vrijeme izlazile iz knjige i formirale UNIN logotip. 

Da bi se to napravilo, kreirana je kocka pomoću alata Create Polygonal Cube. Tada je označena 

kocka te je kreirana mreža pomoću MASH → Create MASH Network.  
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Slika 3.43 Create MASH Network 

Da bi se povećao broj kocki u mreži, ode se u uređivač svojstva (eng. Attribute Editor) te se 

pod MASH_distribute → Number of Points stavi željeni broj. U ovom slučaju je stavljen je broj 

od 50000. 

 

Slika 3.44 MASH mreža s malim brojem kocaka 

 

Slika 3.45 MASH mreža s velikim brojem kocaka  
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Kako je cilj povezati mrežu na logotip, potrebno je otići pod MASH1_Distribute  te pod vrstom 

distribucije (eng. Distribution type) odabrati MASH. Tada se u OUTLINER izborniku uzme 

logotip te se povuče pod Input Mash . 

 

 

Slika 3.46 Spajanje logotipa s MASH mrežom 

 

 

Slika 3.47 Prikaz spojenog logotipa s MASH mrežom 
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Da bi mreža bila ravnomjerno raspoređena po logotipu, potrebno je označiti „scatter uses 

 faces area“. 

 

Slika 3.48 Scatter uses face area 

Da bi mreža dobila teksturu, potrebno je označiti kockicu te tada držeći desni klik → Assign 

Existing Material → odabrati teksturu logotipa koja je prethodno napravljena. 

Sad je potrebno napraviti još jednu mrežu (eng. MASH) iz koje će se prethodno napravljena mreža 

dizati. Odnosno, ta druga mreža će biti pozicionirana u knjizi tako da izgleda kao da se kockice 

dižu iz knjige. 

Da bi se kreirala nova mreža, potrebno je označiti kocku koja je  prethodno korištena za kreiranje 

prve mreže, otiđe se pod MASH → Create MASH Network. Novo kreiranoj mreži se također 

postavi broj kockica na 50000. Tada se novo kreirana mreža označi, ode se pod MASH2 te se 

kreira nasumična mreža (eng. Random). 

 

Slika 3.49 Random – nasumična mreža 
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Da bi se mreža rasporedila horizontalno, potrebno je staviti Y poziciju na 0, te namjestiti X i Z 

poziciju na željene parametre. To će se namjestiti nakon što se uvede knjiga, po njezinim 

veličinama. Da bi se smanjila veličina kocke u mreži, dovoljno je označiti kocku i skalirati. Sad 

više nije potreban logotip, pa se on označi i pritisne se tipka „h“ na tipkovnici, da bi se sakrio. 

 

Slika 3.50 Pozicioniranje drugo nastale mreže 

 

Da bi se drugo kreirana mreža pozicionirala ispod logotipa, treba se označiti mreža → MASH2    

→ Transform. 

 

 

Slika 3.51 Transform  
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Tada se ode pod Controller Null → desni klik na mišu → Create te se pozicionira mreža ispod 

logotipa.  Da bi kreirane mreže povezali, potrebno je označiti prvu te stvoriti mrežu spajanja (eng. 

MERGE) tako da se ode pod MASH1 → Merge. 

 

Slika 3.52 Merge 

 

Tada se ode pod MASH1_Merge te se pod Child Node iz Outliner izbornika povuče MASH 2. 

 

 

Slika 3.53 Spajanje 2 mreže 
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Sada kada su te dvije mreže povezane potrebno je napraviti objekt s kojim će se utjecati na 

mrežu koja se nalazi na logotipu, odnosno, s kojom će se stvoriti efekt kreiranja logotipa iz knjige. 

Da bi se to napravilo potrebno je otići pod MASH1_Merge → Faloff Object → desni klik miša → 

Create. 

 

Slika 3.54 Stvaranje Faloff objekta 

 

 

Slika 3.55 Djelovanje Faloff objekta na mrežu 
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Sada je kreiran objekt kojeg se lako može pomaknuti i time stvoriti efekt kreiranja logotipa. 

Kako je najteži dio stvaranja ove animacije prošao, sada je potrebno animirati knjigu iz koje će se 

logo kreirati. Prvo ju je potrebno uvesti u program tako da se ode pod File → Import → odabere 

se prethodno napravljeni model knjige. 

Knjiga je napravljena od 2 dijela, prvo se odabere lijevi dio te se stavi u vertikalnu poziciju na 1. 

sličicu i tada da bi se postavila oznaka gdje tranzicija počinje, pritisne se tipka „s“ na tipkovnici. 

Tada taj lijevi dio knjige stavi u horizontalnu poziciju, ode se na 240. sličicu i pritisne se tipka „s“ 

na tipkovnici. Sada se odabere desni dio knjige, postavi ga se također u vertikalnu poziciju, ali 

tako da izgleda kao da je knjiga zatvorena te se postavi oznaka za početak tranzicije na 1. sličicu. 

Tada se zarotira u horizontalnu poziciju te se postavi oznaka za kraj tranzicije na 240. sličicu. 

 

 

Slika 3.56 Postavljanje knjige u vertikalni položaj 

 

 

Slika 3.57 Animiranje otvaranja knjige 
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Sada kada je napravljena animaciju otvaranja knjige, potrebno je prethodno napravljene mreže 

pozicionirati iznad knjige i u knjigu. 

 

Slika 3.58 Izlazak mreže iz knjige 

 

Da bi se kreirao efekt formiranja logotipa iz knjige, potrebno je postaviti objekt koji utječe na 

mrežu visoko iznad knjiga, tako da se mreža rasprši. Tada se stavi oznaka za početak tranzicije na 

240. sličicu, jer tada završava animacija otvaranja knjige. Tada se objekt postavi u blizini knjige 

na 480. sličicu. Kako se objekt koji utječe na mrežu polako spušta tako se kockice iz drugo 

kreiranje mreže dižu i kreiraju logotip. 

Sada je potrebno dodati svjetlo i pozadinu. Kao svjetlo će se koristiti svjetlo kupole (eng. Dome 

light) jer pruža jednako osvjetljenje na svim mjestima. Za pozadinu je kreirana izvinuta podloga 

te joj je dodana Lambert tekstura bijele boje.  

Još je preostalo kreirati kamere. Za ovu animaciju kreirane su 2 kamere. Da bi se kreirale, potrebno 

je otići pod Create → Cameras → Camera. 

Prva kamera je pozicionirana na određene vremenske pozicije tako da ona izlazi iz knjige prilikom 

otvaranja knjige. Druga kamera je pozicionirana na određene vremenske pozicije tako da ona 

prilikom kreiranje logotipa pokaže izbliza kako to izgleda te se udalji i pokaže logo u krupnom 

planu. 
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3. Koncept 10 - Morphing efekt 

Ovaj koncept je sličan konceptu 2, samo što će kod ove transformacije modeli postepeno mijenjati 

svoj oblik i pretvarati se u drugi i tako redom. Za animiranje će se koristiti program After Effects 

i modeli koji su prethodno izrađeni. 

Da bi se izradila nova scena u program After Effects potrebno je otići pod File → New → New 

Project. Kada se otvori novi prozor, pritisne se na New Composition te se stave postavke prema 

slici: 

 

Slika 3.59 Stvaranje nove kompozicije 

 

Imenovanje kompozicije ide prema želji. 

Nakon što se je napravila nova kompozicija potrebno je napraviti pozadinu, to se radi tako da se 

pritisne desni klik na vremensku crtu → New → Solid i odaberemo bijelu boju. 

Nakon što je dodana pozadina, potrebno je dodati prvi model animacije, odnosno knjigu. 

To se radi tako što se drži desni klik miša na vremenskoj crti → New → Solid i odabere se crna 

boja i imenuje se „knjiga“.  
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Slika 3.60 Stvaranje solid pod nazivom „knjiga“ 

 

Tada se u prozoru gdje se nalaze efekti i predlošci nađe efekt „Element“ i povuče se na sloj 

„knjiga“ te se  nakon toga pritisne na „scene setup“ da bi se uveo prvi 3D model. Kada se pritisne 

na „scene setup“ otvori se prozor Element efekta, tu se pritisne na „Import“ i odabere se 3D model 

knjige i tada se pritisne „ok“ da bi se uveo model u scenu. 

 

Slika 3.61 Umetanje 3D modela knjige 

Kako je želja da se knjiga prvo vrti pa promijeni oblik potrebno je u  projektnom prozoru pod 

„Effects“ otići na Group 1→ Particle look → Deform → Twist. Tada se stavi oznaka za početak 

tranzicije na 1. sekundi na Twist Z i Phase Y, tada se otiđe  na 3. sekundu i stavi oznaka za 

tranziciju na Phase Y te se stavi  da se okrene za 357 stupnjeva te oznaka  na Twist Z i stavi da se 

okrene za 100 stupnjeva. 
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Slika 3.62 Prikaz oznaka za tranziciju za knjigu  

Sada je potrebno dodati model diplome. Da bi to bilo moguće potrebno je stisnuti desnim klikom 

miša na  vremensku crtu → New → Solid i odabere se crna boja i imenuje se „diploma“. Tada se 

u prozoru gdje se nalaze efekti i predlošci nađe efekt „Element“ i povuče se na sloj „diploma“ te 

se  nakon toga pritisne na „scene setup“ da bi se uveo model diplome. Kada se pritisne na „scene 

setup“ otvori se prozor Element efekta, tu se pritisne na Import i odabere se 3D model diplome i 

tada se pritisne „ok“ da bi se uveo model u scenu. Tada je ponovo potrebno primijeniti Element 

efekt te mijenjati postavke Twist Z i Phase Y. Kako je prethodni model, knjiga, promijenio svoj 

oblik u paralelni položaj, odnosno, oblik diplome, potrebno je napraviti da diploma slijedi tu 

promjenu tako da je potrebno staviti oznaku za tranziciju na 4. sekundu na Twist Z i Phase Y te 

staviti postavke prema slici:  

 

Slika 3.63 Prikaz oznaka za tranziciju za diplomu 

 

Tada se postavi oznaka za tranziciju na 5. sekundi na Twist Z te se stavi 0 stupnjeva. 
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Također se postavi oznaka za tranziciju na 10. sekundu na Phase Y i stavi se da bude okrenuta za 

238 stupnjeva. Još je preostao efekt transformacije, koja se odvija od 8. do 10. sekunde. Tu se 

stave oznake za tranziciju na Twist  Z i postavi se da se okrene za 168 stupnjeva. 

Na kraju je preostalo animirati 3D model UNIN logotipa. Postupak je isti za uvez logotipa. Stvori 

se jednobojna pozadina koja se imenuje „Logo“, primjeni se Element efekt te se postavi scena. 

Sada se postave oznake za početak tranzicije na 10. sekundu na Twist Z i Phase Y i postavke prema 

slici: 

 

Slika 3.64 Prikaz oznaka za tranziciju za UNIN logotip 

 

Tada se postavi oznaka za kraj tranzicije na 11. sekundu na Twist Z i stavi se 0 stupnjeva te još 

jedna oznaka na 15. sekundu na Phase Y i stavi se 350 stupnjeva. 

3.5. Renderiranje 

Renderiranje je proces kreiranje 2D slike na temelju podataka o 3D modelu kreiranog u nekom 

programu kojemu su dodana svojstva poput teksture, boje i materijala. Proces je sličan fotografiji 

i video produkciji jer se kod renderiranja također može kontrolirati osvjetljenje i pozicija 

elemenata. Međutim, u 3D sceni se svaki element mora izraditi u programu prije nego se renderira 

scena. To uzima mnogo više vremena, ali nam daje slobodu da stavimo u scenu što god poželimo. 

Također uzima mnogo vremena jer program prilikom renderiranja mora za svaki piksel fotografije 

računati boju, svjetlinu i još mnoge kalkulacije.  
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Slika 3.65 Prikaz 3D prostora prije i poslije renderiranja [12] 

 

Ponekad je, da bi se renderirao cijeli 3D film poput Shreka ili Ledenog doba, potrebno uključiti 

stotine računala koji rade bez prestanka mjesecima a ponekad i godinama. 

Među popularnijim programima za renderiranje se koriste: Vray, Mental ray, After Effects, Octane 

Render, Iray, Maya, Cinema 4D, 3ds Max itd. 

Za renderiranje ovih animacija korišten je After Effects kao zaseban program i Vray koji je, nakon 

što je instaliran, ugrađen u Mayu. Da bi se namjestile postavke renderiranja u Vrayu, potrebno je 

kliknuti na ovu ikonu: 

 

Slika 3.66 Izbornik za ulazak u postavke rendera 

Kao što je navedeno prije, korišteno je svjetlo kupole (eng. Dome Light) kao osvjetljenje te su za 

sve animacije stavljene ove postavke Vray-a: 
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Slika 3.67 Postavke rendera 

 

Slika 3.68 Postavke rendera 
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Slika 3.69 Postavke rendera 

 

Slika 3.70 Postavke rendera 
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Slika 3.71 Postavke rendera 

3.5.1. Renderiranje 2. koncepta – preobrazba 

Nakon što su namještene postavke za renderiranje, još je samo potrebno odabrati koji pogled, 

kroz koju kameru i koje sličice ćemo renderirati. Kako ova animacije ima samo jednu kameru, ona 

je automatski odabrana te kako se sve događa iz jednog pogleda odabrane su sličice od 1. do 480. 

sličice, odnosno, cijela animacija. 

 

Slika 3.72 Postavke rendera 2. koncepta 
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Da bi se pokrenuo render, potrebno je stisnuti ovu ikonu: 

 

 

Slika 3.73 Tipka za pokretanje rendera 

3.5.2. Renderiranje 3. koncepta – formiranje logotipa iz knjige 

Za ovu animaciju postoje 2 kamere, prva će se kretati iz knjige prema van u trajanju od 1. do 

200. sličice, dok će druga kamera pokazati formiranje logotipa izbliza te na kraju krupni plan u 

trajanju od 200. sličice do 480. sličice. Nakon što bude gotov render pogleda iz prve kamere, 

potrebno je promijeniti kameru kroz koju se renderira (eng. Renderable Camera) i staviti drugu 

kameru, odnosno kameru 2 te ponovo stisnuti „render“. 

 

 

Slika 3.74 Postavke rendera 3. koncepta 
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3.5.3. Renderiranje 10. koncepta – Morph efekt 

Kako je ova animacija napravljena u programu After Effects, tako će se i renderirati u njemu. 

Prilikom renderiranja će se automatski napraviti video koji se dodatno uređuje u programu 

Premiere Pro. Da bi se animacija renderirala, potrebno je otići pod File → Export → Add to render 

Queue nakon čega se otvara ovaj prozor:  

 

 

Slika 3.75 Render Queue prozor 

 

Tada se klikne na „Best settings“ te se stave postavke prema slici: 

 

Slika 3.76 Postavke za render u programu After Effects 

 

Tada se kline na „Comp1.avi“ te se postavi mjesto gdje hoćemo da se renderira i nakon toga 

se klikne ne „Render“.  
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4. Spajanje renderiranih slika 

Za spajanje renderiranih slika i dodatno uređivanje videa animacije koristit će se program Adobe 

Premiere Pro. Kada se otvori program Premiere Pro potrebno je napraviti novi projekt. Nakon toga 

se desnim klikom na projektni prozor pritisne Import te se nađu renderirane slike. Kako je svaka 

slika zasebno potrebno je označiti „Sequence“. 

 

Slika 4.1 Uvoz renderiranih slika  

 

Nakon što su slike uvezene potrebno ih je staviti na vremensku crtu, to se radi tako da se povuku 

iz projektnog prostora na vremensku crtu.  

 

Slika 4.2 Stavljanje uvezenih slika na vremensku crtu 
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Kako 3. animacija, odnosno, koncept 10 nije zasebno slika nego video, nju je dovoljno samo 

pronaći, označiti i uvesti.  

Sada je preostao postupak gdje se uređuje svaka od pojedinih animacija te se svaka od njih spaja 

u zaseban video. Da bi se renderirala svaka skupina slika u jednu video animaciju, ponovo je 

potrebno renderirati.  

Da bi se to napravilo, ode se pod File → Export → Media, stave se postavke prema slici: 

 

Slika 4.3 Postavke renderiranje u Premiere Pro, prvi dio 

 

Slika 4.4 Postavke renderiranje u Premiere Pro, drugi dio 

Klikom na Output Name odabire se mjesto gdje će video biti spremljen. Nakon svega se pritisne 

na Export.   
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5. Zaključak 

Postoji mnogo koraka 3D animacije od kojih je svaki za sebe jednako težak zbog toga je i 

potrebno mnogo vremena i ljudi da se napravi jedna, međutim, od svih vizualnih priloga, 3D 

animacije privlači najviše pažnje, što je i cilj kreatora. 

3D animacije se danas koristi na širokom području dok se najviše koristi u filmskoj produkciji 

i video igrama.  U svijetu gdje mediji prevladavaju te se mišljenja ljudi baziraju na njima vrlo je 

bitno naći jedan koji bi ljudima u vrlo malom vremenu i uz malo truda konzumenta prenio mnoštvo 

informacija. Upravo to je 3D animacija, koja kroz pokretne 3D slike budi zainteresiranost 

konzumenta i tjera ga da ju gleda.  

Istina je da se mnogi programi plaćaju ali postoje i oni koji se ne plaćaju a s kojima se može 

krenuti u svijet 3D animacije poput: Blender, Wings 3D, Source Filmmaker. Kako je tehnologija 

napredovala tako je i učenje postalo lakše, stvaranjem ove animacije pokazalo se da jedan 

pojedinac, uz dovoljno truda i istraživanja, može napraviti jednostavniju 3D animaciju.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

U Varaždinu, ___________________  ______________________________  
Potpis studenta  
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